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1. Overview and Introduction 
 
Welcome to portier®, the software for administration of locking systems. 
This manual contains detailed information on the procedures to be used as well as 
answers to the majority of problems you may encounter. 
 
It is always a good idea to define a clear strategy before you use a technical software 
package. We are ready to help. Ask about our  
 

Strategy Days. 
 
You can also participate in our Training Courses, or we can send one of our 
trainers to your company.  
Please ask for dates and conditions. 
 
 
 
General: 
 
You can use the mouse for every action you do in portier®.  
Basically, the screen display of the portier® software is subdivided into three zones: 
 

1. The top horizontal zone shows the menu commands and a number of 
frequently used buttons on the toolbar. Directly below is a light-blue status bar 
showing current information, e.g. on the object you are working on.  

2. On the left side of the screen you see the vertical Navigator bar. Use the 
Navigator to select a module or feature of the software. 

3. The main part of the screen is your actual working area.  
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2. System Requirements 
 
portier® can be installed on any PC with a processor from Pentium II upwards with at 
least 64MB of RAM and requires about 30MB of space on the hard disk. The 
following operating systems are supported by portier®: 
 
 

• Windows 98 SE, 
• NT (with Service Pack 4, 5, 6, or 6a), 
• 2000, 2000 Server, and ME, 
• XP. 

 
Windows 95 is no longer supported.  
 
The Interbase database server required for operation of the portier® software runs 
under Windows and Linux on the server.  
portier® uses the Windows printer for printing operations. 
 
 
 
 
3. The Installation 
 
Insert the CD into the CD drive of your PC. The installation program on the CD will 
guide you through the installation process; simply follow the instructions on the 
screen.  
In Step 1 you will install the Interbase Server required for operation of the portier® 
software. 
The installation program is in English language; please confirm the steps by clicking 
on „NEXT“, „I agree“, or „YES“. In Step 2 you will install actual portier® software.  
If the installation process does not start automatically, consult the file readme.pfd in 
the main directory of the CD. 
 
Data Conversion for Updates/Cross Updates 
If you update from an older version of portier®, consult the pdf files in the TOOLS 
folder of the CD for detailed instructions. 
Appropriate pdf files are also available if you change over from DataKey (CES), 
KeyOffice (DOM) and/or other software to portier®. 
In many cases, we can do the data conversion for you; please ask for our support. 
 
In some operating systems you will require the explicit authorization to install new 
software (e.g. NT / 2000). This generally applies to networked systems; ask your 
system administrator for details.  
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Installation in a Network: 
Server: 
 
The INTERBASE Server is required. Presently, we use the version 6.0.2.0 supplied 
on the installation CD (can also be downloaded from www.portier.de/download). 
 
Within the setup routine you will be asked for the 
components you wish to install.  
portier® requires the first and second 
components, SERVER and CLIENT (see 
screenshot). 
 
This completes the installation on the server. 
 
 
 
 
 
Client: 
 
The INTERBASE Server is required. Presently, we 
use the version 6.0.2.0 supplied on the installation 
CD (can also be downloaded from www.portier.de ). 
 
Within the setup routine you will be asked for the 
components you wish to install. 
 
On a client, portier® only requires the second 
component, the INTERBASE CLIENT (see 
screenshot). 
 
 
 
Then you will have to install the actual portier® software on every client. The directory 
path is preset to [C:\PROGRAM FILES\PORTIER].  
portier® creates a new subdirectory PORTIER in this path. You can select another 
directory. 
 
After you have installed portier®, copy the database [PORTIER.GDB] once into any 
desired directory on the server. 
Then remove this database (file) on all clients. 
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Then enter the IP address of the server into the file [PORTIER.INI] 
on every client. You can also enter the name of server. 
 
Now, enter the path to the database on the server into the third line of the 
PORTIER.INI file on the client.  
Note: This is the local path on the server. 
 
This also completes the installation on the client. 
 
 
 
 
Known Problems: 
 
In the System 32 subdirectory of the Windows or WINNT directory on a client, there is 
a file SERVICES without extension. After the installation is completed, the last line of 
this file should contain the following entry: 
 
gds_db    3050/tcp                    # InterBase Server 
 
If this entry should be missing, add it at the end of the file. Use an ASCII editor, such 
as the Wordpad.  
Save the changes.  
 
 
Start the portier® software and enter the following user name and password in the 
log-on screen: 
 
User:  START 
Password:  START 
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4. The Menu Bar and the Menus 
 

• The File menu is used to enter new personnel data, keys, cylinders, 
objects, and key rings as well to place orders, and exit the program.  

• The Edit menu is used to edit the existing data. A special option of this 
menu is the Locking Plan.  

• The Issue menu is used for issuing and returning keys.   
• The Query menu invokes the query and reports module. The Reminder 

option reminds you of overdue keys to be returned. 
• The Print menu is used for printing predefined lists. This menu also 

provides an option for exporting search results. 
• The Tools menu is used to set up the system, change the password, or 

select the user language. You also use this menu to import data 
supplied by the manufacturer of the locking system or your supplier, as 
well as to export data. The menu will contain more options when you 
install further tools (e.g. import of personnel data, or similar). 

• From the Help menu you can access the help function of the software 
or obtain information on the current version of your software. 

 
 
 
 
 
 
 
 
 

Below the toolbar, there is another bar colored light-blue, the status bar. Here, 
portier® shows the object (locking system) you are currently working on. Click on the 
small arrow at the right to open a drop-down list box and select another locking 
system, provided that you administer more than one system in portier®.  
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In the Navigator, several modules are listed in black type on a light-
gray background.  
From top to bottom, these are:  
 

• Administration 
• Key Movement 
• Queries/Reports 
• Ordering 
• System 

 
This way, program functionalities belonging together are combined 
into the appropriate module. 
 
 
 
 
 
 
5. The Navigator 
 
The Administration module is used for creation, administration and deletion of objects. 
Cylinders, keys and group keys as well as key holders are handled in a similar way.  
The Key Movement module ist used for issue, return and report of loss as well as 
faulty keys.  
The Queries/Reports module provides various functions for sophisticated queries and 
printing of journals and reports. The Ordering Module is used for management of 
repeat orders and expansion of the locking system.  
The System module is used to adapt the portier® software to your requirements as 
well as to define the users authorized to use the software and providing them with the 
appropriate privileges.   
 
To select a module, simply click once on the module name. 
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6. Objects and Object Administration 
 
Locking systems are designated as "objects" in portier®“. This name was chosen as a 
general term, to also allow for administration of keys for showcases, medicine 
cabinets, furniture, for instance.  
Locking systems from different manufacturers are regarded as separate objects. this 
also applies to different systems of a particular manufacturer.  
 
Select the Administration module from the Navigator by clicking on Administration. 
Then select the first option with the Objects caption below the small building icon from 
the list. Click on the building icon. The dialog box for administration of objects or 
locking systems is now opened in the main working area of the screen. In the top 
section, you may search for the desired object by different criteria in case that a large 
number of objects is administered by the software. The bottom part shows a list of the 
objects already defined.  
 
 
 
 
 
 
 
 
 
 
 
 
7. Creating a New Object 
 
To create and add a new object, click on the Add button in the toolbar shown below 
the menu bar. The Objects dialog box is opened. You can now enter an object 
number of your choice and a description of the object. For instance, you may enter 
the number “1” for the object number and “Administration” or “Department Store High 
Street”, just the way you are used to designate the locking system and, generally, the 
building in which it is installed. Then you can enter further information on the object, 
such as street, zip code and town, into portier®. Below, three comment lines are 
available where you may enter additional internal information on this object or other 
important annotations.  
In the bottom section of the dialog box, you will have to enter some information on the 
locking system.  
 
Please enter this data very conscientiously as it will later be used to generate orders 
automatically.  
The Competence field is used to define the level of privileges a user will later require 
to work on this object. The higher the competence level, the more privileges the user 
or keyholder will require to obtain information on or keys for this object. For details, 
please refer to the chapter “Security” where the significance of competence levels is 
explained.  
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After you have entered all required information, click on the Back button to return to 
the main Administration screen.  
The data is automatically saved in the database when you answer the confirmation 
prompt by “Yes”.  
In your daily work with the program, you will select different objects from the drop-
down list box in the light-blue bar below the toolbar.  
 
To delete an object, highlight (select) it from the list and click on the Delete button.  
 
Note:  
Deleting an object is not possible as long as keys for this object are issued.  
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8. Importing Data from a File or Disk/CD 
 
In the current version, you can directly import data from the majority of important 
manufacturers.  
First, create a new object as described above and save it.  
Always make sure to enter the correct “Locking system number” into the bottom 
section of the Objects dialog box (refer to the locking plan or data disk/CD provided 
by the manufacturer. 
Afterwards, select the menu command:  
 
Tools -> Import data -> XXX data import. 
 

 
In the dialog box, you will 
now have to tell portier® 
where to look for the data 
provided by the 
manufacturer. Click on 
Open DKW (this is the 
format CES use) und 
select the folder where the 
file is located.  
When you have found the 
file, Click on Open. 
portier® now displays the 
detailed data of the locking 
system. Finally, click on 
Import to start reading in 
the data. 
 
 

Note:  
This process may take some time for larger locking systems.  
The data are then directly available to you for further steps.  
 
portier® can import data by CES, DOM, Winkhaus, STUV, and many other 
manufacturers. Many other manufacturers provide the data in KWD format.  
This data can also be imported, though not all of the fields will be filled in the best 
possible way as portier® does not mirror this format exactly. 
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9. Adminstration of Cylinders 
 
Select the Administration module from the Navigator and then click on the Cylinders 
icon.  
The working area shows the Administration of Cylinders dialog box. In the top section, 
you may search for a cylinder by different search criteria. The bottom section displays 
a list of the existing cylinders (generally empty, because this data is administered on 
the server and fetched and displayed only when you make a query).  
 
 
Registering a New Cylinder 
 
Click on the Add button in the toolbar. The Administration of Cylinders dialog box is 
opened.  

 
 
You can now register 
new cylinders.  
 
Let us take a closer 
look how to proceed 
with the registration. 
In the Reference field, 
you can enter a 
consecutive reference 
number, for instance, 
in accordance with 
the numbering system 
in the locking plan 
that the manufacturer 
of the locking system 
may have provided. 
 
 
 

The number of existing cylinders of the same design is entered into the Number of 
Cylinders field. Then you specify whether the cylinders are on stock or built in. The 
Comment field is available for a brief annotation. The Ordering area is completely 
maintained by the integrated ordering system. However, you may enter a number of 
cylinders to be ordered with the next formal order (proposal list) into the Proposal field 
in the middle of the Ordering area. For details, refer to the Chapter “Ordering”. 
 



portier® Locking System Administration 

Page 12 

 
Assignment of Keys 
 
Usually, a single key is assigned to a cylinder. This assignment is made in the center 
part of the screen. There, you can create a new key and assign it to the current 
cylinder, or select a key from the existing keys, exactly pertaining to this cylinder. 
Later, you may change a key assignment or delete it. A cylinder and its key make up 
a locking. The reference number of the locking is therefore always indicated as the 
key number in the dialog box for administration of keys as well as in the key 
assignment in the center of the screen. Several cylinders of the same design may be 
assigned with the same key and therfore have the same key/locking (reference) 
number.  
 
 
The Tabs and Their Significance 
 
In the bottom section of the screen, you see several dialog boxes tiled by tabs.  
The first box is titled Installation data and always shown when the Cylinder dialog box 
is opened. Here, you may enter the location where the cylinder is installed or simply 
leave the fields empty.  
The right-hand section shows technical information on the cylinder, such as e.g. the 
dimensions and color. The two additional fields are available for any desired 
information you may wish to enter.  
The next tab Other data provides three further comment fields for up to 80 characters 
each.  
The next three boxes titled:  
 

• The following keys are locking, 
• The following persons have access, 
• The following persons had access 

 
contain information generated by the software from other data you entered. You 
cannot make any entries into the fields here. Click on Save to save the data, or click 
on Back and answer the confirmation prompt “Record was changed. Save? Yes/No” 
by “Yes”. 
The new cylinder you created should now be shown in the list of existing cylinders. 
 
Editing an Existing Cylinder 
 
To select a cylinder for editing, double-click on a cylinder in the list, or click on it once 
with the left mouse button to highlight the desired cylinder and then select Edit from 
the toolbar.  
With many existing cylinders, it may be difficult to find exactly the one cylinder you 
wish to edit in the comprehensive list of cylinders. Then, you may use the Search 
function. Whether you are looking for a particular object, key or cylinder, you can use 
the Search function in a similar way in all modules of the portier® software. The 
manual contains a dedicated Chapter “Searching” where the options of the Search 
function are described in detail. 
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10. Administration of Keys 
 
Select the Administration module from the Navigator and then click on the Keys icon.  
The Administration of Keys dialog box is opened in the central area of the screen. 
Similar to other dialog boxes of the Administration module, the Search function is 
shown at the top of the dialog box.  
 
The main area displays a list of the existing keys (generally empty, because this data 
is administered on the server and fetched and displayed only when you make a 
query).  
Within this list, portier® makes no distinction between single and group keys. You can 
sort the list by another criterion by clicking on the appropriate column heading or 
reverse the order of sorting. Clicking on the Key number sorts the keys in ascending 
order; a further click sorts the list in descending order of key numbers. 
 
 
Registering a New Key 
 
Click on the Add button in the toolbar to add a new key and open the Key dialog box.  
 

 
For the key number, refer to 
the locking plan.  
You may select a description 
and key name of your choice.  
For the Key kype, you define 
either a single key to be 
automatically connected to a 
cylinder, or a group key 
assigned with a locking 
function later.  
 
 
The Locking method section 
is used to define whether this 
is a conventional single 
locking, central locking,  multi 

locking or shared locking to be defined later (called a definition key in portier®). 
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Then define the Locking type, i.e. mechanical, electrical, or combination 
(electromechanical) locking. In the Inventory section, you first define the total number 
of keys available. The At least field is used to define the minimum number of keys. 
This minimum number is considered for key issue. You will receive a warning when 
the minimum inventory is reached. The other fields will be completed over time while 
you are working with software and cannot be edited by the user (except by the user 
with administrator privileges; refer to the Chapter “Users and Privileges”  of the 
manual).  
 
When you create a new key, you can make an entry into the Depository field. The 
depository location you define here is automatically used for all copies (also called 
instances) of the key. Later, you may move individual copies of the key to another 
depository. Initially, you should select a common depository for all key instances, 
though. In the Ordering section, you can only enter an order proposal. The two 
remaining fields will be completed by the integrated ordering system.  
The Security section is used to assign a competence level to the key and define the 
type of receipt demanded when the key is issued. The Type of receipt list box 
provides four options:  
 

• The type of receipt is freely selectable. 
• The key requires entry of a PIN. 
• The key requires entry of a PIN and a signed receipt. 
• The key requires a signed receipt. 

 
For a detailed description of the competence levels and types of receipt, refer to the 
Chapter “Security”.  
The bottom section of the dialog box is used to assign a cylinder to the key. 
(You remember? When registering a cylinder, you had to define a key assignment; 
now, by analogy, you will assign a cylinder to the key.)  
Save the entries by clicking on the Save button, or click on the Back button and 
answer the confirmation prompt by “Yes”.  
The new registered key now appears in the list of keys. To edit an existing key, look 
for this key in the list and double-click to open the Key dialog box for editing.  
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The Tabs and Their Significance 
 
The Function key tab will later show all group keys also having the locking function of 
this single key.  
The Also closes tab shows which cylinders are also locked by this key (central 
lockings and  multi lockings).  
The Key Holder tab shows all persons presently possessing this key.  
The History tab shows all key holders who had the key in their possession.  
 
 
 
11. Faulty Key / Destroying a Key 
 
The menu bar of the Key dialog box provides a Key command. Click on Key to open 
the menu and select the Destroy key option to destroy a copy of the key, or select the 
Faulty key option to report a key no longer working correctly. 
 
 
 
 
 
 
 
portier® displays a list showing all instances of the current key.  
Highlight the faulty key or key to be destroyed and then click on the Faulty or Destroy 
button in the toolbar. Close the dialog box by clicking on the Back button. The 
changes will be reflected in the Inventory section. You can also later use the Copies 
option of the Key menu to see the status of every instance of the key. 
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12. Administration of Depositories 
 
portier® allows you administer the instances of a key in various depositories from 
which they are issued. This kind of depository administration is common in many 
companies.  
To move a copy of a key to another depository, select the key from the Administration 
of Keys dialog box and click on the Edit button. The toolbar of the Key dialog box 
provides a Copies button.  
Clicking on this button opens the Copies dialog box for administration of key 
instances.  
 

 
You can now select a copy and 
move it to another depository 
(using the Deposit. button and 
choosing a new depository).  
 

 
The New depository field is a list box where you can enter a value or select a 
depository from the list (see below: List Boxes). 
 
 
 
 
 
 
 
 
 
 
You may select (or highlight) more than one key and move them together to a new 
depository. Please confirm every movement by clicking on the Save Button in the 
toolbar. The new depository is immediately reflected in the list of copies. Close the 
dialog box by clicking on the Back button. 
 
How to allow or forbid a particular depository for the users of the portier® software is 
described in the Chapter „Users and Privileges“ of this manual. 
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13. Key Rings 
 
In many companies it is a common practice to combine several single and group keys 
to a key ring.  
To facilitate the work for you, portier® provides you with options for defining, issuing, 
and returning key rings. 
 
Select Edit from the menu bar of the main Administration screen and then choose 
the Key rings option.  
 

 
 
 
 
 
 
The Key Ring dialog box is 
opened showing a list of key 
rings already defined (if any).  
 
 
 
 

 
To add a new key ring, click on the Add button in the toolbar.  

 
 
 
Enter a number and 
name (description) for the 
key ring.  
 
You may also allocate a 
key ring to a department, 
area, or cost center.  
 
Finally, specify the status 
of the key ring and its 
depository. Save the key 
ring definition by clicking 
on the Save button in the 
toolbar.  
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The bottom section of the Key Ring dialog box provides the Connect and Solve 
buttons. Now, you will have to assign keys to the key ring you just defined. Click on 
the Connect button. The already familiar Select Key dialog box for searching keys is 
opened. Search for the key you wish to connect to this key ring. Then click on the 
Connect to key ring button.  
 
Select the instance of the key you wish to connect to the key ring. The key connected 
to the key ring is immediately reflected in the list of keys for the key ring. Prceeding in 
this way, you can connect any number of keys to a key ring. Save the new key ring 
and then click on the Back button to return to the Key Ring dialog box. The new key 
ring is shown in the list of key rings. Again, click on the Back button to return to the 
main menu. 
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14. The Locking Plan 
 
CAUTION:  
Any ill-considered change of the locking functions may confuse the entire software. 
The locking functions in portier® are generally defined by the manufacturer and 
provided on a data disk or CD.  
However, when you register an old locking system, you will have to define the locking 
functions yourself.  
 
Select the Edit menu command from the menu bar at the top of the screen and then 
choose the Locking Plan option. The dialog box for a classical locking plan (matrix) is 
then opened.  
 

 
 
 
Generally, you will have no privileges for this locking plan and also not be allowed to 
make any functional changes (refer to the Chapter “Users and Privileges”). Still, you 
can see which group keys lock which rooms.  
If you have administrator privileges, you are allowed to define the locking functions. 
 
In the upper left section of the locking plan, you select the function to be defined.  
By default, the Group key radio button is selected. The letter used for representation 
in the locking matrix, generally X or O, is displayed in parentheses. 
 
Now define in the horizontal section of the locking plan to which group key you wish 
to assign the selected function. With a single click, the group key is highlighted blue.  
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In the column on the left-hand side of the locking plan, you see all cylinders you 
registered.  
Click on the first cylinder in the Location column. In the locking matrix, a dark-blue 
box now appears at the intersection between the group key and the cylinder.  
 
Now, you will have to define whether the group key locks the cylinder or not. There 
are several options:  
 

• If the dark-blue box is positioned at the intersection between the group 
key and the correct cylinder in the interface, click on Connect button in 
the toolbar. The defined character appears in the locking matrix. To 
remove the connection, click on the Solve button in the toolbar.  

• Click the right-hand mouse button in the dark-blue box and select the 
Connect or Solve option from the context menu. 

• Double-click into the dark-blue box. 
• Enter the letter C (Connect) or S (Solve). 

 
You can then scroll through the list of cylinders using the arrow keys of your keyboard 
and assign the desired functions. If there are several consecutive rows of cylinders all 
locked by this group key, you can highlight them all holding the left-hand mouse 
button depressed while you move the cursor over the rows. In this way, you can 
easily define the functions of a group key. 
 
Note: 
portier® will check the key numbers of the cylinder for every connection. In many 
cases, a key number is assigned more than once.  
portier® will relieve you of the work to track down every cylinder with the same 
number. The moment a cylinder is assigned to a group key, portier® will check 
whether this cylinder number recurs somewhere else in the matrix of the locking plan 
and set the connecting symbol automatically. This avoids errors and takes much of 
the workload from you. 
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Central Cylinders & Multi Lockings 
 
In portier®, a central locking means a cylinder that can also be locked by other single 
keys not directly assigned to it. Imagine an apartment house, for instance: Generally, 
the cylinder in the front door is a central cylinder locked by every apartment key.  
All keys either defined as group keys or central/multi lockings (you remember, when a 
key was registered you had to specify the locking method) are shown horizontally on 
top of locking matrix. If you selected central or multi locking for the locking method, 
defined single keys are also shown at the top, always to the right of the group keys. 
Look for pertinent cylinder in the column on the left and establish the connection by a 
double-click at the intersection. Now, the letter for a central locking, generally “Z”, 
appears in the matrix. 
Please note: For recurrent locking numbers of the central cylinder, portier® will 
automatically set a „Z“ at all relevant locations. Now, look for the keys and cylinders 
that lock into this locking. portier® will acknowledge any further establishment of a 
connection (e.g. by a further double-click) by an “S” in the locking matrix.  
In portier®, a multi locking is similar to a central locking, except that the number of 
lockings is generally restricted to about four. The procedure is therefore identical to 
the procedure for central cylinders.  
 
 
Shared Locking 
 
Shared locking is rarely concerned when planning a locking system, but should also 
be supported by a program for administration of a locking system. 
When you registered the keys, you had the option to select a definition key for the 
locking method. A definition key actually does not exist. It is only required for 
definition of shared lockings in the locking plan. If this situation exists in your locking 
system, you will find a registered definition key at the outer right at the top of the 
locking plan. Select shared locking from the locking plan symbols, and define which 
cylinders are shared-locked in the last column.  
 
Save the locking plan and click on the Back button in the toolbar to return to the main 
Administration screen of portier®. portier® will administer the locking functions 
defined in the locking plan exactly as they were specified. You will know at any time 
who is allowed to lock which cylinders based on the definition of the locking function. 
So, please proceed with utmost care when you create the locking plan. 
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15. Administration of Key Holders 
 
Click on the Key Holders icon in the Administration menu to open the Administration 
of Key Holders dialog box. At the top of the dialog box, the familiar Search area is 
shown (refer to the Chapter “Searching”). Below, you see a list of the existing key 
holders (generally empty, because this data is administered on the server and fetched 
and displayed only when you make a query).  
 
 
Registering a New Key Holder 
 
To register a new key holder, click on the Add button in the toolbar and fill in the fields 
of the Key Holder dialog box.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
No mandatory entries are required in portier®; however, you should at least fill in the 
„Name – 1“ field. The entry from the “Name – 1” field will automtically be taken over 
into the Search string field.  
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You can later change the search string.  
The “Name – 2” field is the obvious place for the key holder’s first name.  
You will notice a small special button to the right of the “E-mail” and “Homepage” 
fields, respectively. When the e-mail address or homepage address is entered 
correctly, you can use the respective special button to directly access your e-mail 
program or internet browser, with the key holder’s e-mail/internet address already 
preselected (in MS Outlook or Lotus Notes). 
 
Five tabs are shown in the bottom section of the dialog box.  
 

 
 
 
By default, the box under the General Data tab is opened. When you complete the 
entries, you may later use any of them to search for the key holder. The Period field 
can be used to enter the period of employment. This feature may be useful, for 
instance, for trainees or external contractors working on a specific project in your 
company. If the End of the job is entered, portier® will warn you at start-up on that 
day that a key holder will leave the company so that you can ask for return of the 
key(s) in good time.  
In the Security section you can define a competence level for the key holder and 
select which type of receipt will be demanded from or allowed to this person.  
The box under the Other Data tab is available for entry of comments.  
The remaining tabs show the keys issued to the key holder, which doors can be 
opened and the key holder’s history of key assignment. After you have made all 
desired entries, close the dialog box by clicking on the Back button in the toolbar and 
answer the confirmation prompt by “Yes” to save the data. 
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Registering a new key holder when a key is issued 
 
You can also register a new key holder when a key is issued. Click on the New Key 
Holder button in the toolbar of the Key Issue dialog box. portier® will then open the 
Key Holder dialog box described above. 
 
 
 
16. Importing Personnel Data 
 
portier® supports the import of personnel data from existing files. A specific file format 
is required for this data. In the „Tools\Import Personaldaten“ folder on the CD as well 
as on our internet site, you will find a detailed description of the record format 
(DEFINITION PERSONALDATEI.XLS).  
This feature allows you to easily import existing personnel information, so you do not 
have to enter this data laboriously over the keyboard. 
 
Proceed as follows: 
Copy the AO_PI.exe (add on Personal Import=AO_PI) file from the TOOLS\IMPORT 
PERSONALDATEN folder of the CD to the directory containing the portier.exe file on 
your server.  
Start the executable file AO_PI.exe once. When you start up portier® the next time, 
you will find a new menu command in the Tools menu:  
 
Add-ons --> Import Personnel Data 
 

  Starting AO_PI.exe once will show:      
 
The procedure is self-explaining; you only have to know where the file containing the 
personnel data is located.  
 
Caution:  
portier® gives priority to personnel data imported from an external file and may 
overwrite data already existing in the program! 
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In the field at the right-hand side of the dialog box, you can now enter the time at 
which portier® shall match the personnel data. Click on the Start button. 
 

 
 
This window may be minimized so it will only be shown in the task bar. portier® will 
then automatically match the personnel data from the specified file daily at the time 
you selected above.  
The personnel data file is available for updating by your personnel department at any 
time.  
 
 
Matching is terminated when you: 
 

 click on the Stop button, or 
 terminate the program, or 
 shut down the server.  

 
You can use portier® normally even when the import program is not running. 
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17. List Boxes 
 
At various places within the software, the collection of data can be facilitated 
considerably using drop-down list or combo boxes.  
You can recognize a list box by a small arrow pointing downwards at the right-hand 
border of the box.  
 

 
 
You may be be familiar with this kind of boxes from other Windows software.  
To create entries for a list box, press the key combination [Alt + F12] when the cursor 
is located in the field. A dialog box listing the existing entries will be opened.  
 

 
 
 
 
 
To edit an existing entry, 
highlight it by clicking with the 
left mouse button and then 
click on the Edit button in the 
toolbar of the dialog box.  
 

Save the changed entry by clicking on the Save button.  
To add a new entry, click on the Add button. Terminate every new or edited entry by 
clicking on the Save button. Click on the Back button to close the dialog box and 
return to the list box. The entries you created are now available in the list box. 
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18. Searching 
 
As searching is handled similarly in all modules, the general procedure is explained 
here in more detail using an example.  
 
Note: The Administration of Cylinders module is opened. 
 
You are looking for the cylinder built into the main entrance.  
In this case, the search term is “main entrance” and used for the “Room description” 
field.  
Select this value from the list of fields by clicking on the small arrow to the right of the 
white “Field” box and choose “Room description” in this example.  
 

 
 
You already know the search term. Enter it into the white “Search term” box: „main 
entrance“. 
Between the “Field” and “Search term” boxes, there is a third box titled “Search 
options”. This box is used to specify how portier® shall handle the searching 
operation. You may choose between: 

• >>equal to<< searches for the exact search term specified in the 
„Search term“ box. 

• >>contains<< searches for the search term at any position within the 
room description. 

• >>begins with<< searches for the search term at the beginning of the 
room description. 

• >>does not contain<< searches for a room description which does not 
contain the search term. 

 
There are two further search options: >>greater than<< and >>smaller than<<. 
These two options are useful for searching numbers as well as single letters.  
„Greater than“ searches for a number greater than or equal to the number you 
entered for the search term.  
For instance, if you are looking for all cylinders on the third floor and the doors are 
numbered beginning with “300” (301, 302,...399) in your system, portier® can search 
for all cylinders on the third floor using the search option „greater than“ “300” 
(includes the number 300).  
The procedure is similar for words and letters, e.g. “greater than” “UF” (for upper 
floor) will show all doors starting with "UF". These options are available all over the 
Administration module and, of course, also in the Query/Reports module (more about 
that later). 
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19. Security 
 
Competence Levels 
You can define a competence level for keys and key holders as well as for the users 
of the software. What does that mean?  
 
When a key is issued, portier® will compare the competence values of the key to be 
issued and the prospective key holder. If key holder does not have at least the same 
competence level as the key to be issued, issue of the key is refused and an 
appropriate message is displayed. This feature allows the administrator, in 
cooperation with his or her superior(s) or the security officer, etc., to define which 
persons will be permitted to receive which keys.  
 
Examples: Keys to medicine cabinets should be restricted to certain personnel; 
cleaning personnel should receive only selected group keys or none at all, etc. 
 
Competence levels may also be assigned to the users of the software. This is useful 
to restrict the range of keys a particular user is allowed to issue.  
These competences are defined in the administration of the system users. 
 
 
Type of Receipt 
 
You can define the type of receipt required or allowed for every key. 
Keys to be issued on a daily basis, for instance, may be issued without explicit receipt 
simply by entering a 4-digit PIN. Important keys may require a PIN and signature, etc. 
The type of receipt can also be defined for key holders. Upon issue of key, portier® 
will check for the highest privilege level and demand the appropriate type of receipt 
for the issue.  
The order of importance is:  
 

• PIN and signature,  
• signature,  
• PIN,  
• freely selectable.  

 
How do you define a PIN: When you register a key holder, select the type of receipt: 
When you choose „PIN“ or „freely selectable“, a dialog box for entry of a PIN will be 
opened. The key holder himself/herself may enter a 4-digit PIN of his/her choice 
which will be known to that person only.  
For external contractors, the PIN is defined by the keys administrator.  
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History 
portier® will trace every key movement and record it in a log file. This file cannot be 
deleted. Using this file, you will always be able to trace who held which key and when, 
etc. 
 
 
Data Backup 
Data backup is handled by the network administrator. portier® will save all data on 
the server only. If you use portier® locally, i.e. on a client computer, please back up 
the following files:  
 
[portier.gdb] and [portier.ini]. 
 
All other files will be restored when you reinstall the software. 
When you replace the hard disk, for instance, simply copy the backed up data to the 
new disk after a reinstallation before you start up portier® for the first time. 
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20. Users and Privileges 
 
After you have installed portier®, there is only one user with the name START and 
password START.  
This user has all privileges (administrator rights).  
 
You should first create a new user and assign all privileges to this user (administrator 
rights = purple). A user having all privileges is commonly called the Administrator.  
 
Select the user administration from the System module and then click on the Add 
button. Enter the log-on (user) name, often an abbreviation or similar in many 
companies, as well as the complete name, password and competence level in the 
fields below. Save your entries.  
 
Then click on the Privileges button and assign the required privileges for every 
program module using the color code.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Click on Save and then on Back to return to the list auf users.  
Then exit portier® and log on again with the new user name. Now remove the general 
user START.  
You are now the only person who has access to portier®. 
Then set up the other users of the program as required.  
 
Every user may change his or her password by selecting Tools -> System -> Access 
administration from the main menu. When the user changes the password, the last 
three passwords used will not be available. This prevents the (often popular) 
alternation between only two passwords. 
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Hint: 
You may setup another user without administrator privileges for yourself. This avoids 
making detrimental changes accidentally during your daily work. Only the 
administrator is allowed to change the inventory data, redefine locking functions, or 
similar. 
 
 
 
Privileges Related to Depositories 
 
A Depository button is available in the toolbar of the User Administration dialog box.  
 
In the Exclude Depository dialog box, you can enter the depositories to which the 
selected user will have not have access.  
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21. Key Movement 
 
The Key Movement module is used for issuing keys, controlling the return of keys, 
and recording lost keys. 
 
Issuing Keys 
 
Click on the Issue icon in the Key Movement module or press the F4 key on the 
keyboard.  
 

 
 
First, select the object for which a key shall be issued from the light-blue status bar.  
 
In portier®, a key is issued in four steps: 
 

1. You search for the person who will receive the key. 
2. You select the key to be given to that person. 
3. You select the desired instance (copy) of that key. 
4. You enter the issue data (date and time) as well as a scheduled return date (if 

applicable) and issue the key to the key holder. 
 
The steps 1 und 2 are interchangeable.  
There is a specific feature in the key search: You can search a key directly using the 
actual key data or its location (cylinder search). Additionally, you can search for a key 
ring to be issued. 
 
Key holders can be searched using various criteria in the dialog box. Enter the 
desired search term and click on the Search button (the button with the binoculars 
icon). 
If you search for a Mr. Doolittle, enter “Doolittle” or at least the first letters of his name 
into the “Name – 1” field. 
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In the 

screenshot, 
the search 
string is 
simply an „A“, 
to search for 
all persons 
with A as the 
first letter of 
their name. 

 
 
 
The bottom section of the screen will show a list of all persons registered in portier®  
and meeting your search criteria. Double-click on a person to select him or her from 
the list.  
If the person you are searching for should not be included in the list, you can register 
a new key holder starting the process directly from this dialog box by clicking on the 
New Key Holder button in the toolbar. 
 
The procedure for registering a new key holder here is exactly the same as described 
in the chapter “Administration of Key Holders”. After you have registered the new key 
holder, clicking on the Back button returns you to the Key Issue dialog box where the 
new key holder will appear in the list.  
 
For the key and cylinder search (door/room), you proceed in a similar way.  
You can search a key ring by its key ring number or description. 
 

 
When you search a key to be 
issued using door/room search 
(cylinder), portier® will display a 
list of all keys locking the cylinder.  
 
Simply double-click on the 
desired room in the list. 
 
When you click the right-hand 
mouse button on a key, portier® 
will show which other cylinders 
this key will lock (important for 
group keys). 
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In the next step, you enter the issue data. The Issue data section of the dialog box 
shows a list of all available instances of the selected key including its depository, i.e. 
where the key is located.  
Select an instance of the key by double-clicking on it. Verify the date and time of 
issue. 
 
If applicable, you can now define the date and time when the key is to be returned. 
portier® will remind you of this at the selected date (refer to the Section „Reminder“ 
below). 
Finally, confirm the procedure by clicking on the Issue button in the toolbar. The key 
issue will be reflected in the list of keys to be issued displayed in the bottom section of 
the dialog box.  
 
In the same way, you can issue further keys or key rings to that key holder.  
To issue keys of other locking systems to the same key holder, select another object 
from the light-blue status bar. 
 
When you have completed the issue, you may print a receipt, if required. Any 
mandatory PIN entries are automatically prompted by portier®.  
 
The issue receipt shows which keys the key holder has received currently, as well as 
any other keys he or she is already holding. 
 
You may print a copy of the issue receipt. You will find the button under the Search 
tab in the Key Issue dialog box: „Print copy of receipt“. 
 

 
 
 
Click on the Back button in the toolbar to close this dialog box and issue further keys, 
if required, or click on Back again to return to the main Administration screen. 
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Returning a Key 
 
Select the Return icon in the Key Movement module, or press the F5 key on the 
keyboard. In this dialog box, you may first search for the person returning the key or 
directly look for the key to be returned.  
You will see a list of all key copies issued to which the search criteria apply. Double-
click on the key copy to be returned.  
You can also click on the Return all button in the toolbar. This will back-post all keys 
held by the key holder. 
Then click on the Return button. If necessary, print a receipt for return of the key.  
 
 
Report of Fault... 
 
...is handled in a similar way as key return (function key F8):  
portier® will adjust the inventory automatically. 
 
 
The procedure for a key ring is similar.  
 
But note:  
When you try to take back a key of a key ring, portier® will notify you that this 
instance of the key belongs to a key ring and will show all further keys on this key ring 
in a dialog box. You can only to take back all keys of the key ring. In this way, 
portier® assures that a key ring is returned either completely or not at all. 
 
An individual key of a key ring cannot be simply returned; you will have to proceed in 
a different way.  
Take back the complete key ring, remove (solve) the copy of the key to be returned 
from the key ring, and then issue the redefined key ring again. Close the Key Return 
dialog box by clicking on the Back button.  
 
 
Report of Loss 
 
The procedure is similar to returning a key. However, start by clicking on the Loss 
icon (or press function key F7). At the end of the procedure, you will receive a report 
of loss instead of receipt for return.  
If only a key of a key ring is lost, first return and back-post the key ring completely. 
Remove (solve) the key from the key ring, re-issue the key ring to the key holder and 
then report the loss. This is the only way to ensure a secure audit trail of individual 
key instances in portier®. 
When a key is found again, only the administrator will be able to change the status of 
this key in the key administration. This requires adjusting the inventory data manually. 
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22. Queries and Reports 
 
Click on Queries / Reports in the Navigator to display the following icons: 
 

• Query history (of key movements) 
• Query key holders 
• Query keys 
• Query cylinders 

 
Unlike the lists you are seeing in the Administration module, the Queries/Reports 
module allows you to define sophisticated inquiries on the available data in the 
database and compile reports (or journals) which you can print and/or use in other 
applications. 
 
Click on the Query History icon in the Queries / Reports module. The Standard Query 
dialog box is opened. Five rows are provided for various search conditions. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
By default, the All check box is checked, i.e. activated. 
When you now simply click on the Search button in the tool bar, you will obtain a list 
of all key movements that have taken place since you installed portier®. You can then 
print the result of the search or export the journal to another application.  
To print the journal, click on the Print button. The Windows Print Manager is started.  
To export the journal, click on the CSV Export button. The CSV format is a file format 
supported by MS Excel as well as many other applications and allows you to import 
and further process the data supplied by portier®.  
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Generally, you will wish to make a more selective query. Let us go through this by 
means of an example. 
 
You took your annual vacation, so you have not been at your workplace for two 
weeks. Now you are back and wish to see all key movements which have taken place 
during your absence. There are two search conditions.  
 
Remove the check mark from the All check box.  
Select the issue date (I-date) in the first row.  
Select “greater than” for the search option and enter the date when you started your 
vacation into the Search term box.  
 

 
 
There is a second condition also to be met. In mathematics, this is is called an AND 
operation. Look at the screen. Directly below the row where you just made your 
entries, you see three radio buttons:  
 

• Ready 
• And 
• Or 

 
Click an the “And” button.  
Again, select the issue date (I-date) in the second row. 
Select “smaller than” for the search option and enter the date when your vacation 
terminated into the Search term box.  
Start the search. As you will have expected, you will see all key issues within the 
period you specified, i.e. during your vacation. Similarly, you may combine up to five 
search terms. Every time you use the “And” button, you instruct portier® that this 
search condition has to be met in addition to another one. When you activate the “Or" 
button, portier® will interpret this such that only one of two (or several) search 
conditions will have to be met.  
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In this way, you may make very complex queries. For instance, you may see all key 
issues to employees of the administration department within the last four weeks, or 
check which trainees working in the sales department received more than three keys. 
 
Similar as described for the key movement history, you can make queries on key 
holders and produce reports using a great variety of search criteria. Queries are also 
available for keys and cylinders.  
 
 
 
Saving a Complex Query 
 
Any complex query you made can be saved and reused later.  
When the result of the query is displayed, click on the Save button in the toolbar. The 
tab for administration of queries is opened automatically and you are prompted to 
enter a description for this query.  
Enter an expressive description for the query that will allow you to easily find this 
query anytime later when you might need it again. After you have entered the 
description, again click on the Save button. The query will be stored in the list of 
standard queries.  
 
HINT:  
You can export the result of a query into an Excel-compatible format (CSV). Click on 
the CSV Export button and specify the name and location of the CSV file. This file can 
be opened and edited in Excel, or used as the control file for merge printing in MS 
Word (similar to a .TXT file).  
 
To recall a memorized query, select any desired icon (History, Key Holders, Keys, 
Cylinders) from the Queries / Reports module and then click on the “Administer 
queries” tab. From the list of memorized queries, you can easily reuse any “old” query 
without repeating the required entries.  
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23. The Ordering System 
 
Please note that a new order is always related to the currently selected object.  
 
To order more cylinders and/or keys, first open the Administration module for keys or 
cylinders and enter the desired quantity into the field 

„Order proposal“. 
(ADMINISTRATION -> CYLINDERS OR ADMINISTRATION -> KEYS) 
 
Then select ORDERING -> ORDER to create a new order for the parts.  
Click on the Add button and complete the required fields. 
 
Supplier 
Enter your preferred supplier as well as your customer number with that supplier in 
the supplier data. You can memorize the entries for subsequent orders by clicking on 
the Supplier button in the toolbar (supplier preselection). This preselection can 
changed later at any time using the same procedure. 
 
Fill in the ordering data as required. 
The Customer No. is the customer number the supplier gave to you. 
 
Order items 
The order items gathered from the order proposals (in the Administration module) are 
listed in the bottom section of the dialog box. You may highlight and delete any of the 
order items. 
 
You can save the order and extend it later.  
To change the order quantity or add new order items, change or enter the value of the 
Order proposal field in the Administration module for keys or cylinders. 
Invoke the order again. Click on the ITEMS button to update the order quantities. 
 
Click on the ORDER button to close the order and prevent any further changes. 
Ordered items are highlighted yellow.  
Click on the PRINT button to print the order form. 
 
Posting: 
When the ordered parts have arrived, there are two options to post the deliveries. 
portier® will automatically update the inventory in the dialog boxes: 
 

 by clicking on the POST DELIVERY button to post all delivered item without 
prompting, or 

 by double-clicking on an individual item – this is also useful for posting partial 
deliveries. 

 
Posted items are highlighted green. 
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Expanding the Locking System 
 
If you wish to order new cylinders or group keys for an expansion of the locking 
system, you will first have to create these cylinders or group keys. This task is 
performed in the Administration module (see above in this manual). When you 
register a new cylinder or group key, set the inventory to “0” and enter the desired 
quantity in the Order proposal field. 
Then initiate a new order. 
 
Important reminder: 
The supplier/manufacturer will absolutely require the pertinent excerpt of the locking 
plan to properly allocate the locking functions.  
 
Please accurately enter which group key locks the new cylinder or which cylinders are 
to be locked by a new group key in the locking matrix. 
(To do this, you will require administrator privileges in the software.) 
 
When you print the locking plan, use the feature to print only those parts you actually 
require. 
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24. Printing 
 
From the main menu bar, you can select various lists for printing.  
Depending on the software version you are using, you may create different layouts 
using the Print Designer.  
 
A printout can be saved using the Preview button and/or sent by e-mail. The List & 
Label file format (*.LL) is used. The Viewer to display the file is included in the 
software package (in the TOOLS folder of the CD).  
 
Alternatively, you may also create print files in many other formats, such as PDF 
(Adobe®), BMP, or JGP, etc. 
 
 

 
Note: This selection of formats is only 
available when the Print preview check 
box in the System Settings dialog box is 
not checked. 
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Printing the Locking Plan 
 
Select Print -> Locking plan from the main menu. 
A locking plan often comprises more than one page. portier® allows you to determine 
in advance how many sheets of paper you will require.  
Click once on the No. of pages button in the Print Locking Plan dialog box to have 
portier® precisely calculate the number of sheets you will need.  
The following terms are used: Vertically successive sheets are designated as pages 
and counted as such (portier® prints A4 landscape).  
Plans comprising more than about 20 group keys (or central lockings, etc.) require 
one or more lateral (horizontal continuation) sheet(s); the first and all further lateral 
sheets are designated as a set in portier®. A plan consisting of 3 pages and 2 sets 
would require 6 sheets of paper, 3 in vertical and 2 in horizontal direction, i.e. 3 x 2 = 
6 sheets.  
 

 
 
You can define which part 
of a locking plan you wish to 
have printed. 
For instance, you may wish 
to print only certain items of 
a locking plan (this requires 
that item numbers exist, 
which is not the case with 
every manufacturer), or 
print only the part for a 
particular department, or 
similar. 
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25. Basic System Settings 
 

 
 
 
 
 
Reminder 
 
portier® can remind you which keys will currently have to be demanded for return 
every time the program is started . A basic requirement for this feature is that you 
entered a date of return when the key was issued.  
Use the Default settings tab of the System Settings dialog box to specify whether you 
wish to be reminded and set the number of days portier® shall advise you in advance 
of pending key returns.  
You can also invoke the Reminder at any time when the program is running by 
selecting:  
 
Query -> Reminder. 
 
 
Default Settings 
 
You may also set which field values you prefer for searching (default field values). In 
the Administration module, portier® will then show the respective field value as 
default search value. 
 
The Locking function tab of the System Settings dialog box is available to define the 
symbols (letters) displayed in the view of the locking plan and used for printing.  
You can also define which three fields shall be shown in the preview of the locking 
plan.  
 
Note: Nine fields will be printed by default. 
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Miscellaneous 
 
You can set the user language by selecting “Tools -> System -> Choose language 
from the main menu (depending on the program version). portier® presently supports 
the following user languages: German, Dutch, English, and French (depending on the 
program version). You can select another user language at any time. portier® will 
memorize the selected user language with the user name.  
 
 
 
26. Concluding Remarks 
 
 
Dear user of our software, 
 
we are convinced that portier® will be a useful tool for your everyday work.  
You, the user, will be aware of your requirements in more detail and how portier® 
might support you still better.  
Please tell us your wishes and ideas. This will help us to evolve portier®, and all 
users will benefit from our continuous improvement.  
 
On the internet, at www.portier.de, we regularly publish new tips and tricks, answers 
to frequently asked questions (FAQ) as well as forms designed by users and provided 
to us, naturally including the author (coming soon).  
 
We are looking forward to talk to you.  
Send us an e-mail to info@portier.de with the following Subject: Ideas.  
 
We hope for a mutually successful cooperation and thank you on behalf of the 
portier® team for the purchase of our software. 
 
 
 
Georg Stüer & Axel Baruschke 


